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Abstract:
This paper introduces you to the Excel regression tool. It shows you how this tool can be used to perform linear
regression analysis (one independent variable) as well as multiple-regression analysis (two or more
independent variables up to a maximum of 16). It also shows you how to interpret Excel’s regression output.
For regression analysis involving only one independent variable, the paper shows you how to select the Line Fit
Plots option so that Excel will create an XY (Scatter) chart at the time that Excel computes and writes the
regression output to the workbook. Moreover, you will learn how to modify the XY (Scatter) chart so that it
communicates better.
KEYWORDS: Linear regression, multiple regression, regression chart, intercept, coefficient of determination,
coefficient of X in linear regression analysis, coefficients of X1 and X2in multiple regression analysis, and
residuals
REGRESSION ANALYSIS
Excel’s regression analysis tool performs linear regression analysis, which fits a line through a set of
observations using the "least squares" method. Regression is used in a wide variety of applications in finance
and accounting to analyze how the value of a single dependent variable is affected by the values of one or more
independent variables. You can then use the regression results to predict
the value of the dependent variable based on values of the independent
Note:
The
Data
Analysis
variable(s).
With Excel, you can perform both regression analysis (one independent
command displays a Data
Analysis dialog box that lists
variable) and multiple-regression analysis (two or more independent
variables up to a maximum of 16). Excel also enables you to choose the
statistical and engineering tools.
Line Fit Plots option to create a Line Fit Plots column chartand the
These tools are part of the
Residuals Plots option to create a residuals column chart. However,
Analysis ToolPak add-in that is
included with Microsoft Excel. If
because Excel can create only two-dimensional XY charts, only one
independent variable and one dependent variable can be represented in
you do not see the Data Analysis
a regression chart or a residuals chart. Whenever you select the line fit
button in the Analysis group of
plots option or the residuals plots option and there are two or more
the Data tab’s Ribbon, then the
independent variables, Excel will create a single column chart or
Analysis ToolPak add-in was not
installed. See the Appendix on
residuals column chart for twoor more independent variables. However,
the XY (Scatter) chart, which is changed from the column chart,will not
installing the Analysis ToolPak.
include the predicted value of the dependent variable with a straight
line. The examples that follow include regression analysis using one
independent variable, modifying a column chart created by the Line Fits Plot option so
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that it becomes a an XY (Scatter) chart, and multiple regression with two independent variables.

•
•

•

•
•

•

•
•
•

To perform regression analysis, click on the Data Analysis button in the Analysis group, which is on the far
right of the Data tab’s Ribbon. If you do not see the Data Analysis button or the Analysis group in the Data
tab’s Ribbon, it means that, although the Analysis Toolpakadd-in was placed on your hard drive when
Microsoft Office 2010 or 2007 was installed, this add-in was not installedfor Microsoft Excel. Thus, you should
review Appendix at the back of this paper to see how to install the Analysis Toolpakadd-in.
If you click on the Data Analysis button, you will then see a list of data analysis tools in the Analysis Tools list
box of the Data Analysis dialog box. Scroll down the list until you see Regression, as shown in Figure 1. Click
on Regression and then click on the OK button. Excel then displays a Regression dialog box, as shown in
Figure 2. The required ranges and options in the Regression dialog box are as follows:
Input Y Range. Allows you to enter the range of the dependent variable. The data for the input range must be
in a column.
Input X Range. Allows you to enter the range of the independent variable(s). The data for the Input X Range
must be in columns. If two or more independent variables are present, they must be located in adjacent columns.
Excel orders the independent variables in ascending order from left to right, using 1, 2, 3, and so on for the
variable names in the summary output table.
Labels. If the first row in the input range includes labels (i.e., text) that describe the independent variables,
check the Labels box. Excel then generates the appropriate row titles for the summary output table. If your input
range does not contain labels, then the Labels check box should be clear.
Constant is Zero. Check the Constant Is Zero box only if you want to force the regression line to pass through
the origin.
Confidence Level. The default confidence level is 95%. If you want an additional level included in the
summary output table, check the Confidence Level box, click on the text box to the right, and enter a confidence
level (i.e., 99% or 90%) that you want Excel to apply to the regression in addition to the default 95% confidence
level.
Output Options. Excel writes the regression output, in the form of a summary output table, to (1) an output
range in the active worksheet, (2) a separate worksheet within the active workbook, or (3) a separate workbook.
Choose any one of the three options by clicking on its option box. If you choose the output range option, click
on the text box at the right and enter the cell address of the upper-left corner where you want the summary
output table to appear. When Excel writes the summary output table, it will consist of nine columns and
eighteen or more rows, depending upon the other options selected.
Residuals. Check the Residuals box if you want Excel to write the predicted values of Y and the residuals to a
residual output table.
Standardized Residuals. Check the Standardized Residuals box if you want Excel to write the predicted
values of Y, the residuals, and the standardized residuals to a residuals output table.
Residual Plots. Check the Residual Plots box if you want Excel to create a column chart for the independent
variable(s) versus the residual. If you choose this option, Excel will also write the predicted values of Y and the
residuals to a residual output table.
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• Line Fit Plots. Check the Line Fitt Plots box if you want Excel to create a column
n chart
cha for predicted values
versus the observed values of Y in relati
relation to the observed values of X. If you choose
hoose this option, Excel will
also write the predicted values of Y and th
the residuals to a residual output table.
• Normal Probability Plots. Check the N
Normal Probability Plots box if you want Microsoft
Micro
Excel to write the
observed values of Y and the related
ted sam
sample percentiles to a probability output table and
a to generate a chart
plotting the observed values of Y andd the sample percentiles.
Figure 1
Selecting thee Regression
R
Toolin the
Data Analysiss Dialog
Di
Box

Figure 2
Regression Dialo
ialog Box
Linear Regressio
gression Analysis

Using Excel
As an example of performing regression
ssion analysis with Excel, consider the materials-han
handling cost example. In
this example, you are a new employee
loyee in the finance department of Fabuglasss Plastics,
Plas
Inc., a maker of
fiberglass products for the automotive
tive in
industry. A major component of Fabuglass’
s’ manufacturing
man
costs is the
cost of handling the materials used in the molding process. You were asked by the Vice President
P
of Finance to
look at the relationship between thee cost of materials and the weight of materialss handled
hand
each month. As a
result, you created a new workbook,, ente
entered the cost and weight data for the year 2012 in Sheet1, changed the
Sheet1 tab name to Linear Regressio
ression, and saved the workbook as Fabuglas.
las. The
T
Linear Regression
worksheet, which is illustrated in Figure
igure 3, documents the materials-handling costs
ts associated
asso
with the weight
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of materials used for the months Janua
January 2012 through December 2012. Each month
mont represents a pair of
observations of materials-handling costs aand weight of materials, for a total of 12 pairs of observations for the
year.
Figure 3
nt V
Variable) and
Materials-Handling Costs (Dependent
Weight of Materials Used (Independent
ent V
Variable) for the Year 2012
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Now open the workbook FabUGlas and se
select the Linear Regression worksheet. To perform
perfo regression analysis,
click on the Data Analysis button in the Analysis group of the Data tab’s Ribbon; choose
hoose Regression in the Data
Analysis dialog box, and then clickk on O
OK. Select the following ranges and options
ons in the Regression dialog
box:
Click on the Input Y Range text boxx and eeither select the range D6:D18 with the mouse
ouse or
o enter the range at the
keyboard.
Click on the Input X Range text boxx and eeither select the range C6:C18 with the mouse
ouse or
o enter the range at the
keyboard.
Check the Labels option box.
Check the Confidence Level box, click
lick oon the related text box at the right, and then
en enter
ente 90 (for a confidence
level of 90%).
optionNew Worksheet Ply:.If you don’t wantt the output
o
to be in a new
If necessary, click on the Output option
worksheet immediately to the left off the Linear Regression worksheet, then enter the new
n worksheet name in
the option box to the right of New Worksh
rksheet Ply:.
Check the Line Fit Plots box (Selecting
cting tthis box also causes Excel to write the predicte
redicted values of Y and the
residuals to a residual output table below the summary output table. Therefore, if you select
se
the Line Fit Plots
box, it is not necessary to check the Resid
Residuals options box.).
If your Regression dialog box matches
tches tthe one shown in Figure 4, click on OK to have
h
Excel perform the
regression analysis, write the summary
ary an
and residual output tables to the output range,
e, and create the line fit plots
chart.
Figure 4
Entering
g Ranges
R
and Selecting
Options in Regression Dialog
Box forr Fabuglass
F
Regression
Example

After performing the regression analysis
alysis, Excel writes the summary output table,
e, beginning
beg
in cell A1 (the
upper-left corner of the output range),
ge), to column I (nine columns) and rows 1 through
throug 18; and the residual
output table to columns A through C and rows 24 through 36. In order to see all off the information
in
in summary
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output table, you will have to adjust the columns widths to fit the row and column titles. Because Excel
highlights the columns that contain the summary output table when you click on OK, click on the Format button
in the Cells group of the Home tab’s Ribbon and then choose the AutoFit Column Width command to adjust the
column widths to fit the text and values in the summary output and residual output tables. After adjusting
column widths, your summary output and residual output tables should be similar to those which appear in
Figure 5. The coefficient of determination (R2) is in cell N25; the standard error of the Y estimate is in cell N27,
the Y-intercept (or constant) is in cell N37; the t-statistic for the Y-intercept is in cell P37, the coefficient of
Weight of Materials, the independent variable, is in cell N38, and the t-statistic for the coefficient of Weight of
Materials is in cell P38.
The values in the Lower 95% and Upper 95% columns (columns R and S) can be used to develop interval
estimates of the Y-intercept and the coefficient of X at the 95% confidence level. Similarly, the values in the
Lower 90% and Upper 90% columns (columns T and U) can be used to develop interval estimates at the 90%
confidence level. However, these procedures are beyond the scope of this paper.
As you can see in Figure 5, Excel provides quite a bit of useful regression output, including t-statistics for both
the Y-intercept and the coefficient of X. Now review the regression output. The R2 value of 0.74264004 in cell
N25 indicates that approximately 75 percent of the change in the dependent variable Materials-Handling Costs
is explained by the change in the independent variable Weight of Materials. How do you interpret a t-statistic?
A rule of thumb is that, if the absolute value of a t-statistic is greater than or equal to 2, you can accept the
related sample coefficient as being significantly different from 0; this indicates that a significant relationship
exists between the independent variable and the dependent variable. As you can see in cells P37 and P38, the
values of the t-statistic for the Y-intercept and the coefficient of Weight of Materials are approximately 4.1 and
5.4, respectively. Since each t-statistic is greater than 2, you can conclude that a significant relationship exists
between the independent variable Weight of Materials and the dependent variable Materials-Handling Costs.
Now rename the worksheet with the regression output as Linear Regression Out put
The standard formula for linear regression with one independent variable is:
Y(X) = a + bX
where:
Y(X) = Predicted value of the dependent variable
a = Y-intercept
b = Coefficient of the independent variable
X = Any value of the independent variable Weight of Materials
In the worksheet, the a (Y intercept) can be found in cell N37, and the b (coefficient of X) can be found in cell
N38. Thus, using Excel terminology, the regression formula in this example could be written as:
=N37+N38*X
or as
=645980.1856+192.5*Weight of materials
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Figure 5
Regression
Summary
Output
and Residual
Output
Tables

Whenever you check one of the Residual
siduals options, such as the Line Fits Plots option,
ion, in the Regression dialog
box, Excel creates a residual outputt table as part of the regression output. In creating
ing the
th residual output table,
Excel computed a predicted value of Y ((i.e., a value on the regression line) for each
ach observation
ob
of X and the
residual, which is the difference between
etween the observed and predicted values of Y for each
e
observation of X.
Rename the worksheet as Linear Regressi
gression Output
Modifying the Regression Chart
Because you selected the Line Fitt Plots box, Excel created theLine Fit
TIP:: Create
Crea a copy of the
Plots chart to the right of the summar
mmary output table. However, in its
Linee Fit Plots chart and
present form, the chart is difficult
lt to rread and interpret. To facilitate
modify
dify the
t copy. Thus,
changing the chart type and modifying
ifying the chart, select the chart by
should
uld you
y
damage the
clicking on it. When you select a chart,
hart, round handles with holes in them
copy
y when
w
modifying
appear along it borders. Next, copy the ch
chart, paste it, and then increase its
the chart, you can always
size as follows:
recopy
opy the
th original chart
and modify
mod
the copy all
ear R
Regression worksheet as follows:
1. Copy the chart to cell A22of the Linear
over
er again.
agai
• Copy the chart to the clipboard (e.g.,., pres
press Ctrl + C). You should find the
upper-left corner of the chart in cell V21.
21.
• Select cell A22of the Linear Regression
sion w
worksheet and then paste the chart from thee clipboard
clipb
(e.g., press Ctrl +
V).
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2. Increase the chart’s size as follows:
Position the mouse pointer on the black handle in the lower-right border of the chart until you see the doubleheaded arrow.
• Press the right mouse button, drag the lower-right border down and to right until the chart extends to the lowerright corner of cell J48, and then release the mouse button.
3. If necessary, click on the Full Screen button in the Worksheet Views group of the View tab’s Ribbon in order to
display rows 22 to 48 simultaneously on the screen.
Next, modify the chart by completing the steps below:
• The square data markers (symbols) that appear to form along a diagonal in the chart represent the predicted Y
data series. Change the data markers from symbols to a regression line as follows:
⇒ Click on any of the data markers and then choose the Format Data Series command from the shortcut menu.
Excel will display a Format Data Series dialog box.
•

⇒ Click on the Marker Options tab in the dialog box and choose the None option, as shown in Figure 6.
⇒ Click on the Line Color tab and choose the Solid Line option.
⇒ Click on the arrow at the right end of the Color list box to display the color palette and choose the color Dark
Red, which is in the left-most color under Standard Colors in the color palette, as illustrated in Figure 7.
⇒ Click on Close to close the dialog box. As a result, Excel will replace the data marker symbols with a dark red
regression line.
• Click on the chart title:
⇒ Change the font and font size to Times New Roman and 12 points, respectively.
⇒ Edit the chart title so that it reads as follows: MONTHLY COST OF HANDLING MATERIALS RELATIVE
TO WEIGHT OF MATERIALS FOR YEAR 2012. Insert a line immediately before “TO” and move that part of
the title beginning with “TO” to the next line by pressing the Enter key.

199

International Journal of Arts and Commerce
rce

Vol. 1 No. 5

October 2012

Figure
re 6
Marker
ker Options Tab of the
Format
at Data Series Dialog
Box
•
•
•
•
•
•
•
•
•
•
•
•
•
•
• Click on the X-axis title:
 Change the font and font size to Times
es Ne
New Roman and 10 points, respectively.
 Edit the title so that it reads Weightt of M
Materials (in pounds). Move “(in pounds)” to the
th next line by pressing
the Enter key.
• Click on the Y-axis title:
 Change the font and font size to Times
es Ne
New Roman and 10 points, respectively.
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Figure
re 7
Line Color
Co Tab of the Format
Data Series
Ser Dialog box
•
•
•
•
•
•
•
•
•
•
•

•
• Click on any of the category names along the X axis:
 Change the font size of the category name
names to 9 points.
 Change the scale of the X axis by choo
choosing the Format Axis command in the shortcu
hortcut menu to display the
Format Axis dialog box, clicking onn the Axis Options tab, if necessary, and changing
ging the
th following options in
the Axis Options portion of the dialog
og box
box:
 Check the Fixed option in the Minimum
mum bbox and then change the minimum value to
o 3000.
3000
 Check the Fixed option in the Maximum
mum bbox and then change the maximum value, if necessary,
nec
to 6000.
nec
to 1000.
 Check the Fixed option in the Majorr unit bbox and then change the increment value, if necessary,
 Click on Close to close the dialog box.
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• Click on any of the values along the Y axis:
 Change the font size of the category names to 9 points.
 Change the scale of the X axis by choosing the Format Axis command in the shortcut menu to display the
Format Axis dialog box, clicking on the Axis Options tab, if necessary, and changing the following options in
the Axis Options portion of the dialog box:




•


Check the Fixed option in the Minimum box and then change the minimum value to 1000000.
Check the Fixed option in the Maximum box and then, if necessary, change the maximum value to 2000000.
Check the Fixed option in the Major unit box and then, if necessary, change the increment value to 200000.
Click on Close to close the dialog box.
Click on the Legend:
Change the font size to 9 points.

 Right-click on the legend and choose the Format Legend command from the shortcut menu to display the
Format Legend dialog box.
 In the dialog box, click on the Border Color tab, click on the Solid Line option, click on the arrow on the right
of the Color box, and then click on the fourth color from the right under Standard colors in the palette of colors.
 Next, click on the Border Styles tab and change the width to 1.25.
 After changing the width, click on the Close button to close the dialog box.
After completing the above steps, view the modified regression chart. It should look like the one shown in
Figure 8. If it does not, repeat one or more of the above steps in order to make the necessary changes. In your
chart, the individual markers (i.e., symbols) represent the observed values of Materials-Handling Costs. The
straight line represents the values along the regression line (i.e., the predicted values of Materials-Handling
Costs).
Since the regression analysis quantified the relationship between materials-handling costs and the weight of the
materials handled and indicated that the relationship was significant, you should be able to observe this
relationship in the chart. And in fact, the sample observations are tightly clustered around the regression line.
Thus, the regression chart reinforces your observations from regression analysis. It is also a lot easier to explain
the relationship between the dependent and independent variables to nonstatisticians by presenting the data in a
regression chart than by trying to explain to them statistical terms such as R2, the Y-intercept, the coefficient of
X, and the t-statistic.
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Figure 8
Modified
Regression
Chart

Multiple-Regression Analysis Using
ng Ex
Excel
The preceding regression example include
included only one independent variable. But suppose
ppose that the Vice President
of Finance met with the Vice President
ent of Production to review the results of your Excel regression analysis and
the regression chart. During the meeting,
eeting, the Vice President of Finance suggested
d that the dollar value of the
materials used might affect the cost
st of hhandling the materials, since higher-priced
d materials
mat
must be handled
more carefully and consequently take
ke lon
longer to handle. After returning from the meeting
eeting, the Vice President of
Finance provides you with information
tion oon the dollar value of materials used during
ing the
th twelve-month period
ending December 31, 2012. She asks
sks yo
you to add the dollar cost of materials used
ed as a second independent
variable in predicting materials-handling
dling ccost.
ion an
analysis using Excel, the observations of thee independent
inde
variables must
When you conduct multiple-regression
be in the same rows and in adjacent
nt colu
columns. Now select the Multiple Regression
n worksheet
wor
in the Fabuglas
workbook. It should match that shown
wn in Figure 9. The steps you used in performing
ing linear
lin
regression analysis
with one independent variable are applic
applicable to multiple-regression analysis, except
ept that
tha here you specify the
Input Y Range as E6:E18 and the Input X
X-Range as C6:D18. Also, the Line Fit Plots
lots box
bo should be cleared if
checked. Then check the Residuals box iin order to have Excel write the predicted values
value of Y and the related
residuals to the residual output table.
e. If yyour Regression dialog box matches the one
ne shown
sho
in Figure 10, click
on OK to have Excel perform the multiple
ultiple regression analysis and write the summary
ry output
out
and residual output
tables.
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Figure 9
Materials-Handling
Costs
(Dependent
Variable) and Two
Independent
Variables:
Weight of Materials
Used (Independent
Variable 1) and
Dollar Value of
Materials Handled
(Independent
Variable 2)

Figuree 10
Selected
ed Ranges
R
and Option
ptions for
Fabuglass
lass Multiple
Regression
ssion Example
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After performing the regression analysis
alysis, Excel writes the summary output table,
e, beginning
beg
in cell A1 (the
upper-left corner of the output range),
ge), to column I (nine columns) and rows 1 through
throug 19; and the residual
output table to columns A through C and rows 25 through 37. In order to see all off the information
in
in summary
output table, you will have to adjust
st the columns widths to fit the row and column
n titles.
title After making those
adjustments, your summary output and re
residual output tables should be similar to those which
w
appear in Figure
11.
Now review the regression output. The co
coefficient of determination (R2) is in cell B5;
5; the
th standard error of the
Y estimate is in cell B7; the Y-intercept
rcept ((or constant) is in cell B17; the t-statistic for
or the
th Y-intercept is in cell
D17, the coefficient of the first independ
ependent variable (i.e., weight of materials) and
d its related
r
t-statistic are in
cells B18 and D18, respectively; and
nd the coefficient of the second independent variable
variabl (i.e., dollar value of
materials) and its t-statistic are in cells B1
B19 and D19, respectively.
2
The R value of 0.903132468 indicates
ates th
that approximately 90.3 percent of the change
ge in the dependent variable
is explained by the changes in the two in
independent variables. Moreover, the values
es of the
t t-statistic for the Yintercept and for both independent variab
variables are greater than 2, indicating that a signific
ignificant relationship exists
between each independent variablee and the dependent variable Materials-Handling
ing Costs.
C
Now rename the
Sheet 2 worksheet as Multiple Regression
ession Output.
Figure 11
Summary
Output and
Residual
Output Tables
for
Two
Independent
Variables

The standard formula for multiple regress
egression with two independent variables is:
Y(X1,X2) = a + b1X1 + b2X2
where:
Y(X1,X2) = Predicted value of the depen
dependent variable
a = Y-intercept
b1 = Coefficient of Weight of Materials
erials ((first independent variable)
X1 = Any value of Weight of Materials
rials ((first independent variable)
b2 = Coefficient of the second independe
pendent variable
X2 = Any value of Dollar Value of Mate
Materials (second independent variable)
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As noted previously, the Y-intercept can be found in cell B17, the coefficient b1 of X1 can be found in cell B18,
and the coefficient b2 of X2 can be found in cell B19. Thus, using Excel terminology, the regression formula in
this example could be written as:
=B17+B18*X1 +B19*X2
or as
=554684.79+100.09*Weight of Materials +0.165*Dollar Value of Materials
Because you selected the Residuals box, Excel wrote the residual output, including a predicted value of Y for
each observation of Weight of Materials and Dollar Value of Materials, to the range A25 through C37. There
are two possible reasons for having Excel compute the predicted values of Y and the residuals: One, you may
want to compare the predicted values of Y with the observed values of Y (or review the residuals, which
represent the differences between the predicted and the observed values of Y); and, two, at some later point in
time, you may want to chart the observed and predicted values of Y relative to one of the independent variables.
Moreover, if you have access to a graphics program that can create a three-dimensional (i.e., 3-D) XY chart,
you may want to create a multiple-regression chart.
SUMMARY
The regression feature in Excel allows you to perform both linear regression with one independent variable and
multiple-regression analysis using the “least squares” method. After you specify the range of the independent
and dependent variables and choose options in the Regression dialog box, Excel performs the regression
analysis and writes the regression results to a summary output table. Included in the summary output table are
R2, the standard error of the Y estimate, the Y-intercept, the standard error and t-statistic of the Y intercept, the
coefficient of each independent variable, and the standard error and t-statistic of each coefficient. Other
regression options create a line fit plots chart and write the predicted values of Y and related residuals to a
residual output table.
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APPENDIX – INSTALLING THE
E ANA
ANALYSIS TOOLPAK
With Microsoft Excel 2010 (similar
lar but different from Excel 2007), you add in the Analysis ToolPak by
clicking on the Filecommand on the left--side of the screen and then clicking on Options
tions on the left side and near
the bottom of the dialog box. Excell displ
displays the Excel Options dialog box. Click on the Add-ins tab at the left
side of the dialog box. Next, click on Ana
Analysis Toolpak to highlight it, as shown in
n Figure
Figu 12. Next, make sure
that the Manage list box near the bottom of the screen containsExcel Add-Ins, and
nd then
the click on Go, which
appears to the right side of the Manage
age lis
list box. Excel then displays the Add-Ins dialog
g box,
b
as shown in Figure
13. Make sure that the Analysis Toolpak
lpak has a check in its box and then click OK. You
ou should
sh
then see the Data
Analysis button in the Analysis group
up of tthe Data tab’s Ribbon.

Figure 12
Excel Options Dialog Box
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Figure 13
Add-Ins Dialog Box
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